PLAYBILL GUIDE

Okay, this is basically all I (Iris Howley) can remember, on how to put together West’s playbill
for the musical. I suggest you refer to previous year’s playbills for some additional help, or
contact myself at ikh23@drexel.edu or guerre girl@yahoo.com. I can also be instant messaged
at gingko711 and Mitul can be instant messaged at carrom100. If you’re really stuck, you can
call my home number at 856-779-8509, and someone there will be able to get you in contact with
me. Warning, this may be out of date. It was written in July 2003.

Anyways, I hope it has everything you need. I only go through the utmost basics of Photoshop
6.0 (you will be using 7.0. It’s practically the exact same). You really need a manual for that
program, or just to spend time playing with it! A lot of this manual was taken from the manual I
wrote for Visions (West’s World Language Literary Magazine). There’s some hand written notes
that go along with this. They’ve been given to Mrs. Savidge. Some of it is a repeat of what’s
already here, some of it you may find useful.

BASICS

1. Save often. Burn to a CD often. This will keep you from losing everything if the computer
dies.

BASIC IMAGES (Photoshop)

Not to intimidate you or anything, but Photoshop is one of the most complicated programs I’ve
ever come across. There are soooo many options and things you can do with it, I'm just including
the basic ones. If you want something more advanced you can ask me...or get yourself a manual.

Oh, and this part was written using Photoshop 6.0. It should work with newer versions.

TOOLS

This is just to explain what all the parts of Photoshop are that I refer to.
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SCANNING IMAGES

Black and White Images (Usually text ads, referred to as lineart) should be scanned at 1200 dpi.
Grayscale images (photographs) should be scanned at 300 dpi. Check those numbers with the
printer-guy beforehand. If it was an image published somewhere (as in a magazine or
newspaper) be sure to ‘descreen’ it when you scan it. Each scanner and scanning program is
different, I cannot give exact directions on how to scan an image, or upload from a digital
camera, etc. Just make sure you save each image in an ‘Images’ folder on your computer, with an
appropriate, descriptive name.

If you’re using Photoshop to scan images, which I highly suggest, you will scan an image by
going to the ‘File’ menu, selecting ‘Import’, and then selecting the appropriate option from there.

ABOVE ALL, USE .TIF (OR .TIFF) FILES!!

You can always ‘Save As...” .jpg files to .tiff files with Adobe Photoshop, if one of your
workers doesn’t have .TIFF files.

FIXING MISTAKES

Never fear! If you made a mistake, you can go back several steps and fix it!

Go to ‘Edit’ on the menu bar, and select ‘Step Backward’. Repeat this until you’ve fixed your
mistake.



OR

Go to this menu on the right:
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This is a list of everything you’ve done to the image. Click the option you’d like to go back to. If
the mistake hasn’t gone away, go up a little more on the history, it’s there.

Z00M

The time will come when you need to see the image close up. Here’s my recommended way.

1. Usually, the image is a lot larger than it appears. Go to ‘View’ on the menu bar.
2. Then select ‘Actual Pixels’.

3. From here, you can go to View>Zoom In (or Out) as needed.

4. To get back to the original size, go to ‘View’ and then ‘Fit on Screen’.

Try ‘Print size’ and the other options, see what zoom you like best.

ROTATING

If your image was scanned in the wrong way, here’s how to turn it around.

1. Go to ‘Image’ on the menu bar.
2. Then go to ‘Rotate Canvas’ and select the appropriate option.
(CCW: counter clockwise; CW: clockwise)




CROPPING

Cropping works particularly well for images that were scanned in crookedly.

1. Select the (diagonal square) tool button from the tool bar.
2. Left-click and drag from the upper left to the lower right.
3. Adjust the boundaries of the dotted line until you see the parts you wish to keep.

Areato cut away (darlcened)

Areato keep

4. Hit the ‘Enter’ key.

RESIZING

I HIGHLY suggest that you do not do this, and so, [ won’t go into great detail. (Resizing images
causes you to lose much of the image’s quality).

Under ‘Image’ on the menu bar, there is ‘Image Size’ and ‘Canvas Size’. It is difficult to explain
the difference.

When you play with ‘Canvas Size’ it will cut off pieces of the picture without resizing it. It deals
with the dimensions of the document, not so much the image. ‘Image Size’ has to do with the
stretching of the image. Once selected, a menu pops up. I suggest you make sure that, under
‘Document Size’ you keep the percents the same. (You may have to switch the boxes that say
‘inches’ to ‘percent’.)

BRIGHTENING/DARKENING

For those images that just aren’t quite light/dark enough.

1. Go to ‘Image’ on the menu bar, and then ‘Adjust’ and then ‘Curves’.
2. The following menu should appear:



Play with the image by left clicking the line (originally, it’s slanted. Here, it’s sloped)) and
dragging. Release, and then try a different spot on the line. I can’t really explain how to use this
beyond. Just play with it.

3. Click the ‘OK’ button once satisfied, or ‘Cancel’ if you’d like to start over again.

ADJUSTING

Sometimes, images are scanned with smudges or dirt shows up on them. There are a handful of
tools that I've used to fix this. Make sure your image is a Grayscale file by going to ‘Image’ on
the menu bar, then ‘Mode’ and then Grayscale.

SMUDGE

For fixing tiny mistakes. Dirt, acne problems, etc.

1. Click the (finger) tool button. If you don’t see it, left-click and hold on a button that looks

like either of these: O A and then select the option. This is the smudge tool.

2. Go to the blemish, left-click and drag, starting right around the blemish, and then going over
this.

3. Release, and repeat as needed.




CLONE STAMP

Fixes large problems, basically by copy and pasting other sections of the image onto the error. I
suggest you zoom in a bit to see the image clearer.

1. Click the (Stamp) tool button.

2. Press the ‘Alt’ key when you left-click a spot on the image you wish to copy/paste over the
blemish.

3. Then, left-click and drag over the blemish. Starting at the blemish, and moving around it.

Play with this option, I can’t exactly explain it either.
You may wish to adjust the copy-space. This is on the Options Bar. Click the DownArrow, and
then the following window will appear. I suggest that you only pick from the 2" and 3" lines.
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BASIC LAYOUT (PageMaker)



Okay, so you have most of your text and ads, and most of your images all ready to be put into a
magazine. Here’s how to do it!

STEP ONE OF LAYOUT

Open Adobe Pagemaker. [ know 6.5 and 7.0 are very similar, so this manual works for either of
them, really.

TOOLS

What I will be calling each of the tools in this manual.

I call this the menu:

EVAdobe PageMaker 7.0
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The buttons below “File, Edit, Layout, etc” will be called menu buttons. We don’t use the menu
buttons very often.

This is the tool bar. The buttons on the tool bar will be called tool buttons. It’s mainly used for
creating objects.
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CREATE A DOCUMENT

More than likely, you’ll just use the blank document that I’ve likely created for you on a CD.
But, if that doesn’t work out, here’s how to create a playbill document.

1. Go to ‘File’ on the menu bar.

2. Select ‘New’.

3. The following menu will show up. Make sure that all the options, check boxes, etc. are the
same as this menu:

E
Druraray Printer on FILE: |_

Of course, ‘Number of Pages’ really depends on the number of pages you wish to start with.
Publications must ALWAYS HAVE PAGE NUMBERS IN MULTIPLES OF 4!!!!

The ‘compose to printer:” option isn’t important.
4. Hit the ‘Okay’ button, and you should have the document appear.

Note: I suggest splitting the playbill up into SEVERAL documents. Something like 8 pages or so
to a file. Make sure you number these files appropriately for easier navigation.

Beginning Basics
The first two pages and the last two pages are reserved as the cover and inside covers.

Don’t go over the blue and pink guidelines. Yes, these are just margins, but you need some
space along the outside of each page.



Save often!! Save with different file names from time to time! Burn back up copies of the
document every once in awhile! I suggest you create a ‘Playbill’ folder on your computer,
so you can just burn this folder and its contents each time. (Put a ‘Fonts’ folder for all your
font files, ‘Ads’ folder for all your advertisement images, ‘Images’ for all the crew and bio
photos, and then another ‘Playbill’ folder for your various parts/copies of the playbill.).

Do not change the arrangement of the Playbill folders after you have saved the document
once. This will mess up your linked images, and you will have to browse through your

computer to find where you have moved each and every one of the images.

Pick fonts ahead of time. Save them in the ‘Fonts’ folder.

PAGE NAVIGATION

Use the little numbered pages in the bottom left hand corner in order to get to the page you want:
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If they’re not there, make sure your document is maximized.
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INSERTING/REMOVING PAGES

This is quite self explanatory. Basically:

1. Go to ‘Layout’ on the menu.

2. Select ‘Insert Pages’ or ‘Remove Pages’.

3. A window will pop up. Change to your desires.



REARRANGING PAGES

[ prefer to:
1. Click the tool button.

2. Left-click and drag from the upper left hand corner of the page, to the lower right hand corner.
3. Release clicker.

4. Before doing anything else, go to ‘Edit’ next to ‘File’.

5. Select ‘Cut’.

Be careful not to copy/cut any other pages before ‘pasting’ this page, or you will lose it!! Maybe
‘Edit’>"Undo’ will work?

6. Go to the empty page where you wish to place this one.

7. Go to ‘Edit’ and then ‘Paste’.

8. Move all the objects as one, until they’re where you want them.

A note on ‘Sort Pages’:

When you use this option, it tends to really screw the layout up. So be CAREFUL when using
this!

1. Go to ‘Layout’ on the menu.

2. Select ‘Sort Pages’.

3. Drag and drop(rearrange) pages as desired.

4. Click ‘OK".

PLACING TEXT

1. To place text, go to the (T for text) tool button.

2. Then, left-click the page where you will be putting text, and drag the mouse (while still
keeping the clicker down) down, and to the right.

3. Release the clicker.

4. There should be a blinking cursor. Type what you want.

You will likely copy and paste many of your crew lists, benefactors, and bios. To do this:

la. Highlight (left click and drag) the poem in the Word document.

2a. Select the ‘Edit’ which is located next to ‘File’.

3a. Select copy.

4a. Go to the Pagemaker document.

Sa. Follow steps one, two, three, and four as above.

6a. Without doing anything else, select ‘Edit’ next to ‘File’.

7a. Then choose ‘Paste’.

Often, this will mess up the arrangement of the words of the poem. Be careful and be sure to fix
this! Also, make sure all the text fits in the text box (see ‘Changing Text Box Size’).



EDITING TEXT

1. Click the (T for text) tool button.

2. With your cursor, highlight the text you wish to edit. (Highlight = left click and drag)
This only edits the text you have highlighted, not the entire text box.

3. The object bar should now have many options for you. Here are the ones you might use:
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Just change each as you desire.

Try to use a small number of font face styles. No more than 5. They become annoying to have to
include on the CD. Usually, I pick one font for the cover and emphasized names/titles and then
another basic (arial or times new roman) for the rest. Take special note of the small caps button.
1 use this for names in the bio section.

For alignment:

Sometimes you will have to change the alignment of text different from what appears. Do this at
your own discretion to change the look of the text, or to fit it into space.

1. With the text still highlighted, go to ‘Type’ on the menu (it’s on the same line as ‘File”).

2. Then select ‘Alignment’.

3. Select left, center, right, justify, or force justify.

1 suggest that you play around with these options just to see what they mean. The ‘justify’ is
what is used in mostly used in newspapers, we use it for bios.

MOVING TEXT

1. You can move text around by clicking the tool button.
2. Then, left-click the text you wish to move.
3. Click and drag the text where you wish it to go. It moves the entire text box as one object.

Vertical text:
This is used mainly for placing the artists’ names by their work.

1. Click the text with the - tool button.

2. Click the - (spinning arrow) tool button.

3. With the funky looking cursor, left-click one of the bold, black corner boxes on the text box.
Drag your cursor around until you get what you want. This may take repeated tries, and some
tinkering before you fully understand it.



CHANGING TEXT BOX SIZE

Sometimes, the text box is too small for all the text in it. If it is, you will see a red arrow at the
bottom of the text box, when you left click it with the tool button:
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Just left click and drag that red arrow downwards. Release the clicker. Keep dragging the red
arrow and releasing until there is no red arrow.

Sometimes, having lots of extra space at the bottom of a sentence will cause a red arrow to
appear. If this is so, just eliminate the extra carriage returns and spaces use delete/backspace as
required.

PLACING IMAGES

NEVER EVER COPY AND PASTE AN IMAGE!!!
To place an image, first of all, it must be saved to your computer.

1. Go to ‘File’ on the menu, and then select ‘Place’.
2. A browse screen will appear. Find your image in this screen, and then double click the image’s
name.

3. An ‘Adobe Pagemaker’ window will popup, asking if you want to ‘Include complete copy in
the publication anyways?’. Click ‘No’.

If you include a complete copy of the image, the document will eventually get so large and
become so slow, it’s really annoying. Not including a complete copy of the image will cause the
computer to link to the image, and continue to refer to the document’s place in the computer
each time the image needs to be displayed. Or something like that. Overall, just click ‘No’.

4. Your cursor will look something like this: 5. Now, to place the image at 100% its size, just
left click the page. Usually, 100% is too large. So...

5. Left-click the screen, while dragging downwards and to the right, until you’ve created a box
that seems about the right size for the image.

6. Release the clicker.



EDITING THE SIZE OF AN IMAGE

I suggest that you ALWAYS do this, to prevent the image from stretching.

1. Click the image with the tool button.
2. Look at the object bar. There are many options there for you to adjust the image with.

The actual widthiheight of
the image
The z-y coordinates of the nage in

the document
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Make sure the center square i the largest by clicking it

Adjust as needed.

MOVING AN IMAGE

1. Left-click the image with the tool button.
2. Drag and release the when the image is where you want it to be.
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SAME.

LINING UP OBJECTS (images and/or text)

Another way to move text and images.

1. Click the object with the tool button.

2. Look at the object menu.
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Remember the object’s y-coordinate.

3. Click the object you wish to line up with the first object. Make sure the upper left square is
largest, as in the object menu of the first object.

4. Type in the first object’s y-coordinate into this new object’s y-coordinate on the object menu.
This will give you two objects with different x-values, but the same y-values.

IMAGE COLLAGES

Not a playbill thing: I have always been a fan of filling one full page with multiple pieces of
artwork. To do this, I had to mess with the object menu of the image objects. It’s a combination
of ‘Lining up objects’ and ‘Editing the Size of an image’. Basically, work with the inch width
and heights (not the percentages) of the images, and then line them up accordingly. Play with
this, it’s hard for me to explain.

DELETING OBJECTS

1. Click the tool button.

2. Left-click the object you wish to delete.
3. If it’s selected (you see the black squares on the corners), push the ‘Delete’ button on your
keyboard.

BORDERS

Always used to go around bio-photos and ads!!!

1. Double click the (slanted line) tool button.
2. You get a menu, that looks like this:
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Edit it how you like. ‘Stroke weight’ is how many pixels thick your border will be. 1 point is just
a very thin line.

3. Click ‘OK’.

4. Click the IE‘ (white rectangle) tool button.

5. Draw your border by left-clicking and dragging down to the right.

6. You can adjust the border more exactly by using the object menu, as you would with an image
or text box.

WRAP AROUND TEXT

Wrap around text looks like this:

I don't know
how you
expect to
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Wistons. It may take 5 hours, but
it's better than schooll

1. Left-click the tool button, and then the image you wish to have the text wrap around.

2. Go to the menu buttons, and select (the ‘text wrap’) button.
3. A menu will pop up. It should look like this:



Text Wrap Ed |

“Wrap option: -EIK
Ty T
% i“mm‘mi Cancel |
Teut Flows
el [t
i (5

Standaff in inches:

Left Right IF
Top II:I_1 Bottom IIZI.1

[T "wiap text on zame layer anly

Make sure all the appropriate wrap/text-flow is selected. ‘Standoff in inches’ numbers can be
adjusted to your desire. Sometimes, you may wish to have one or two of them be ‘0’ (usually the
Bottom).

4. Click ‘OK’.

5. Now move your text object onto the image, and continue moving it until you have what you
want.

OBJECTS COVERING OBJECTS

This is either something you need to fix, or something you 're trying to do.

1. Click the tool button.

2. Left-click the object that is covering the other object

3. Then, go to ‘Element’ on the same menu as ‘File’.

4. Select ‘Arrange’.

5. Pick ‘Send Backward’, and keep repeating this until the object no longer covers the other
object, but is behind it. OR, select ‘Send to Back’.

Think of all the objects on your document as sandwich fillers. One is the ham, another is the
cheese, etc. You have to move the ham downwards (backwards) on the pile, in order for the
cheese to be on top. This may take moving the turkey, lettuce, tomato, etc. downward as well.

PLAYBILL SPECIFICS



The previous stuff was all pretty basic/generic. That was all slightly edited from what I gave the
Visions crew (vou’ll probably notice some slip-ups through it, [ suppose). But this next section
was specifically written for playbill. It’s not very organized, sorry.

RANDOM

If benefactors entries lack a message or personal name, either write up a message, or put the
name of the person(s) it’s directed to.

Headshot (for bios) dimensions: Around .833” wide by 1.25” in height. Try and keep the
dimensions around that size, though you can change it however you like, just try not to stretch
the images.

AD LAYOUTS

An individual box (on the object menu) is:

W 2.265 H 1.875
Keep in mind, that’s an 1/8" a page ad. Place them so the boxes so look good. Box point size is
2.

When ads are inserted, depending on size, you may need to select and delete, and then resize the
ad, accordingly. Usually, for large size ads, you just delete a box or two, and resize one box, or
you can resize using the object menu.

When you want to make new ad page, select all 8 boxes of another ad page, then select “Edit”
from the menu, and then “Copy”. Then, go to the page you want to make an ad page and type the
“Insert” key while holding the “Shift” key.

BIOS AND PICS

1. Place the desired headshot, and using the object menu, make it the desired dimensions.

2. Make a 2 point box with the same dimensions as the headshot.

3. Use the object menu to adjust the x & y coordinates of the headshot and box to the same.

4. Now, select both by left-clicking and dragging slight to the left and top down to slightly right
and below of the two objects.

5. On the menu select “Element” then select “Group”. The box and headshot are now together.
See the text wrap section to see how to make the bios wrap around the photograph. Bios are
copy & pasted, and then aligned as ‘Justify’ or ‘Force Justify’, depending on preference.




DONE

HANDING IT IN

Playbill will usually fit on one CD
Move the old copies/versions of Playbill into another folder that you will not burn.
Make sure you have all your font files on the CD!

1 suggest that you use your computer ‘find’
capability (usually located on the Start
Menu) to search the name of your font.
Then, from that, find the location of the font
file, by looking at its ‘properties’.

If ‘Find’ does find the font file, you will need
to open Adobe Type Manager, find the name
of the font you re looking for in the left hand
side. Right click the name, and then write
down the location, including the name, of
the font file. Then, using Windows Explorer,
hunt the file down, and then right click and
‘Copy’ the file. Then go to your ‘Fonts’
folder in the Visions’ folder, right click and
‘Paste’.
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